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SCOPE 

Products Covered by this Manual 
This User Manual provides information on how to install, configure and use the Teleterm 
M2 Series RTU’s. 
 
This manual covers the following product Models: 

Models Description 
C2360B-xx Teleterm M2 ‘B’ Series RTU’s 

 
 

Manual Revision History 
Date Revision Comments 
12 Jan 2009 1 Initial Issue 
2 Mar 2009 2 Conet/r configuration details expanded 
3 Jun 2009 3 DIT Table added 
26 Aug 2009 4 Number of 0-30V channels corrected to 4 
2 Feb 2011 5 Ethernet option moved to Model C2360C versions 

 
 
Software Copy Available 

This manual is available in Adobe Acrobat pdf format. 
The pdf file is named UMC2360BR05.pdf 
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1. GENERAL DESCRIPTION 

1.1 Overview 
The TELETERM M2 Series of RTU’s is designed specifically for industrial telemetry and 
remote I/O applications, combining powerful industrial network communications features 
with ease of use. 
1.1.1 Communications 
The TELETERM M2 Series RTU is available with a wide range of communications network 
options to enable communication with a broad selection of devices and machines. 
All I/O and configuration data variables are automatically accessible through Data 
Interchange Registers in a single “Data Interchange Table”, allowing the implementation of 
Remote I/O systems “out of the box”. 
1.1.2 Programmable 
Conventional remote I/O systems can be implemented without the need for any software 
programming, but the inclusion of two separate programming facilities within the M2 
provides a powerful customisation capability. 
The programming facility delivered in every M2 RTU is the EziForth programming language. 
This facility is suited for simple logic control, custom protocol implementation and similar 
tasks. The EziForth Workbench programming software is the development environment 
used for these applications. 
1.1.3 Memory Card 
The SD Card Slot provides the ability to store readings on a removable SD Card for remote 
logging applications. The data written to the SD Card is under control of the User Program, 
allowing flexibility of file structure and contents. 
1.1.4 Versatile Configurable Inputs and Outputs 
A Teleterm M2 Series RTU provides the ideal low cost remote interface to your assets or 
processes to provide the control and information that you need to optimise your operations. 
The M2 RTU’s are all equipped with 12 direct Binary and Analogue Inputs and Outputs. 
Each I/O can be uniquely configured as an input or output; analogue or digital. 
1.1.5 Built-in Serial Port 
An RS232/485 serial port supporting a number of protocols including Modbus and Conet/s 
allowing signals from a variety of sources to be monitored and controlled via the M2 RTU 
communications network of choice. 
As a basic I/O outstation, the M2 RTU’s are easily configurable using the free Omniset 
configuration software. Using Omniset PRO, the M2 Series can also be configured remotely 
over the installed network. 
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Figure 1.1: Front View of the Teleterm M2G with internal GSM modem 

 

1.2 Product Feature Matrix 
The following table identifies the features available on each of the products in the range: 
 

Product 
Name 

Order 
Code Notes 12 I/O 

RS232/ 
RS485 
Port 

GSM/ 
EGSM/ 
GPRS 
Port 

3G 
UMTS 
Port 

Conet 
Port 

2.4GHz 
63mW 
Radio  
Port 

920MHz 
100mW 
Radio 
Port 

868MHz  
315mW 
Radio 
Port 

920MHz  
1W 

Radio 
Port 

1x 
RS232 

1x 
RS232/ 
RS485  

M2 C2360B-0            

M2G1 C2360B-11 1           

M2G2 C2360B-12 2           

M2C1 C2360B-21            

M2R1 C2360B-31 3,4           

M2R2 C2360B-32 3,5           

M2R3 C2360B-33 3,6           

M2R4 C2360B-34 3,7           

M2S1 C2360B-41            

Table 1-1 – Product Feature Matrix 

NOTES: 
1. The EGSM/GPRS port is a quad band device operating on 900/1800/850/1900MHz. This 

is suitable for use on most countries’ GSM networks. Consult the factory for specific 
compatibility with your network. 

2. The 3G UMTS port is a tri band device operating on 850/1900/2100MHz. This interface is 
specifically approved for use on the Australian Telstra NextG network. 
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3. The M2R version is available in a number radio band options to comply with different 
country regulations. Please ensure that the correct unit is specified for your application. 

4. 2.4GHz Band is suitable for use all countries. 
5. 920MHz Band is suitable for use in USA, Australia and New Zealand. The M2R3  version 

has fixed output power of 100mW. This version is not recommended for new installations. 
This model has been replaced with the M2R4. 

6. 868MHz Band is suitable for use in Europe, and Southern Africa. 
7. 920MHz Band is suitable for use in USA, Australia and New Zealand. The M2R4 version 

has presettable output power of 1mW to 1W. The M2R4 is NOT compatible with M2R3 
installations. 

 

1.3 Feature Descriptions 

1.3.1 I/O Terminals 
The Teleterm M2 is equipped with 12 software configurable input/output points (IO 
points). Each IO point can be individually configured as digital or analogue, input or 
output selected from the options given in the following table: 
 

I/O 
Point 

Terminal 
No. 

Digital 
Input 

Analogue 
Input 

Digital 
Output 

Analogue 
Output 

1 5 Yes 0-30Vdc Yes - 
2 6 Yes 0-30Vdc Yes - 
3 7 Yes 0-5Vdc Yes - 
4 8 Yes 0-5Vdc Yes - 
5 9 Yes 0-5Vdc Yes - 
6 10 Yes 0-5Vdc Yes - 
7 11 Yes 0-5Vdc Yes - 
8 12 Yes 0-5Vdc Yes - 
9 13 Yes 0-5Vdc Yes - 
10 14 Yes 0-5Vdc Yes - 
11 15 Yes 0-30Vdc - 0/4-20mA 
12 16 Yes 0-30Vdc - 0/4-20mA 

(See the specifications section for electrical specifications of each IO point option) 

Table 1-2 – I/O Configuration Options 

 

1.3.2 Programming Port (RS232) 
The programming port is normally reserved for all programming functions in the unit. 
Although it is possible to reconfigure this port as an additional serial port, this option 
should be carefully considered, as it does make trouble shooting and field 
maintenance more difficult. 
When using this port as a serial port, the serial port settings can be changed to suit 
the application. This will make this port incompatible with the programming tools. The 
SD pushbutton can be used to switch between programming mode and user mode. 
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1.3.3 Port 1 (RS232/RS485 Serial Port) 
The Teleterm M2 RTU is equipped with a user serial port, labelled PORT 1, on the 
front of the unit. This serial port can be used as a communications port to third party 
equipment. 
This serial port can be wired for RS232 or RS485 communications. 
In normal mode, the serial port can be configured for a number of protocol sets: 

a) Modbus protocol (Master or Slave device, ASCII or RTU protocol) is available 
on this port allowing easy connection to other third party products such as 
Alarm Annunciators, PLC’s DCS or SCADA systems. 

b) Conet/s protocol is available for integration into Conet networks and for 
programming the Teleterm M2. 

c) User control which allows custom protocols to be implemented in the 
EziFORTH programming language in the M2 RTU. 

 

1.3.4 Port 3 onwards (Network Port) 
Each M2 RTU in the series is equipped with a different network port called PORT 3 
(and onwards if there are more ports). The type of network port is dependent upon the 
Model of M2 RTU. The following table gives an overview of the available network port 
options and their applications: 
 

Product Order 
Code 

Network 
Port Description 

M2 C236xB-0 None The standard Teleterm M2 is equipped with only a 
programming port, and an RS232/485 serial port 

M2G 
C236xB-11 
C236xB-12 

GSM 

The M2G is equipped with an internal GSM modem 
capable of communicating over standard GSM mobile 
phone networks using dial-up, SMS or GPRS data 
services. 
The M2G is ideally suited for communicating with 
remote assets over very large distances (even different 
countries). 
The -11 option unit is compatible with all GSM networks 
worldwide. 
The -12 option unit is compatible with the Telstra NextG 
network in Australia. 

M2C C236xB-21 Conet 

The M2C is equipped with a Conet network port. 
Conet is the world’s most rugged Industrial LAN, 
capable of running over existing plant cabling up to 10 
kilometres. Up to 126 nodes may be connected to a 
Conet network in a token passing peer-to-peer 
architecture. 
The M2C is ideally suited for local in-plant 
communications where the cost of laying special 
networking cable is considered uneconomical for the 
application, but where existing cabling (of any sort) is 
already in place. 
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M2R 
C236xB-31 
C236xB-32 

Radio 

The M2R is equipped with an internal FHSS digital 
radio transceiver operating in the licence free radio 
bands. 
FHSS stands for Frequency Hopping Spread Spectrum 
and is an advanced technique for implementing secure 
error-free radio communications in the presence of high 
interference. 
The M2R is ideally suited for communications in areas 
where cable connections are impossible, and distances 
are relatively short (between 0.5km and 10km 
dependent upon the model and antenna selected) 
(See the selection guide for choosing the model 
appropriate for your country of use.) 

M2S C236xB-41 

RS232 
+ 

RS232 
/485 

The M2S is equipped with two additional serial ports. 
Port 3 is an RS232/485 port with the same pin-out and 
functionality as Port 1 – the built in serial port. 
Port 4 is an RS232 port with full hand-shaking 
capabilities suitable for interfacing to external modems, 
or to any other equipment capable of supporting a 
RS232 connection. 
The M2S is ideally suited for interfacing to external 
modems or to other third party equipment using the 
RS232/RS485 standard. 

Table 1-3 – Network Selection and Applications 
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2. Installing the Teleterm M2 RTU 

2.1 Connecting the Internal Clock Battery 
Before installing the Teleterm M2, the internal clock battery must be connected. 
The Teleterm M2 is shipped from the factory with a “Battery Protector Tab” protruding from 
the left side of the unit. Pull on the tab to remove before use. 
 
See section 5 for battery replacement details. 

2.2 Mounting the Teleterm M2 
The Teleterm Teleterm M2 is designed to be clipped to one of the following mounting rails: 

Top Hat Section (DIN) Rail 35/7.5mm in accordance with EN 60715: 1981 

Top Hat Section (DIN) Rail 35/15mm in accordance with EN 60715: 1981 

G Section Rail 32mm in accordance with EN 60715: 1981 
 
 
 

45

89
,5

54,5
46,5155

109,5
Height including serial cable

5

7,5

 

Figure 2.1: Mechanical Mounting Dimensions for the Teleterm M2 
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2.3 Connecting direct Inputs and Outputs 
The Teleterm M2 has a unique feature of allowing each I/O point to be software configured 
as analogue or digital, input or output, for the best possible utilisation of I/O in any 
application. 
 
Review your I/O requirements, and then make the optimum allocation of the I/O, taking into 
account the variations in specification of each I/O Point. 
See Table 1-2 – I/O Configuration Options. 
2.3.1 Connecting Digital Inputs 
Digital Inputs must be connected in accordance with the following schematic: 

1
2
3
4

n

+V

0V

+-

9-30Vdc
Supply

IOP 1 - IOP 12  

Figure 2.2 - Digital Input Connections 

Digital Input Specifications: 
Parameter Condition Value 
LED Indication Input On Green LED On 
Absolute Maximum Input Voltage  30Vdc 
Minimum High Level Input Voltage  3Vdc 
Maximum Low Level Input Voltage  2Vdc 
Input Current Vin = 5V 0.7mA 
Input Current Vin = 10V 1.7mA 
Input Current Vin = 12V 2.2mA 
Input Current Vin = 24V 4.7mA 
Input Current Vin = 30V 6.0mA 
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2.3.2 Connecting Digital Outputs 
Digital Outputs must be connected in accordance with the following schematic: 

1
2
3
4

n

+V

0V

+-

9-30Vdc
Supply

IOP 1 - IOP 10

+

-
+V

 

Figure 2.3 - Digital Output Connections 

Digital Output Specifications: 
Parameter Condition Value 
LED Indication Output On Green LED On 
Maximum Continuous Output Current Output On 50mA 
Maximum Peak Output Current 10ms max 200mA 
Maximum current for ALL Digital Outputs Outputs ON 500mA 
Minimum High Level Output Voltage   +VPSU – 2.5V 

 
 
2.3.3 Connecting Analogue Inputs 
Analogue Inputs must be connected in accordance with the following schematic: 

1
2
3
4

n

+V

0V

+-

9-30Vdc
Supply

IOP 1 - IOP 12

+

-

0-5/30V

 

Figure 2.4 - Analogue Input Connections 
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Analogue Input Specifications: 

I/O Points 1-2, 11 and 12 
Parameter Value 
LED Indication None 
Absolute Maximum Input Voltage 30Vdc 
Input Impedance Minimum >500kΩ 
Minimum Measurable Input Voltage 0V 
Maximum measurable Input Voltage 30V 
Resolution over 0-5.5V 6mV 
Resolution over 5.5-30V 30mV 
Accuracy over 0-5.5V 0.15% of reading + 6mV 
Accuracy over 5.5-30V 0.15% of reading + 30mV 

 
I/O Points 3 to 10 
Parameter Value 
LED Indication None 
Absolute Maximum Input Voltage 30Vdc 
Input Impedance Minimum >1MΩ 
Minimum Measurable Input Voltage 0V 
Maximum measurable Input Voltage 5.5V 
Resolution 6mV (10 bits) 
Accuracy 0.15% of reading + 6mV 

 
 
2.3.4 Connecting Analogue Outputs 
Analogue Outputs must be connected in accordance with the following schematic: 

 

1
2
3
4

n

+V

0V

+-

9-30Vdc
Supply

IOP 11 - IOP 12

+

-

4-20mA

+V

 

Figure 2.5 - Analogue Output Connections 
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Analogue Output Specifications: 

Parameter Value 
LED Indication None 
Maximum Output Voltage Drive +VPSU – 5.0V 
Minimum Controllable Output Current 0mA maximum 
Maximum Controllable Output Current 23mA minimum 
Output Resolution 25μA 
Output Accuracy 0.1% of reading + 25μA 

 

2.4 Connecting the Programming Port 
The programming port is normally reserved for the programming function, but can be used 
as an additional RS232 serial port if desired. 
When connecting the programming port to a standard PC compatible serial port (DB9), the 
Omniflex programming cable Part Number M1831A (supplied separately) can be used. 
If another cable is to be used, the following connections will apply: 
 

Signal Name DB9F Pin No. FCC-68 Pin No. 
Rx Data from M2 2 4 
Tx Data to M2 3 1 
Ground Reference 5 2 

All other pins are reserved and must not be connected. 

Table 2.1: Pin allocation of connectors on M1831A programming cable 

2.5 Connecting Serial Port 1 
This serial port is capable of RS232, RS422 or RS485 communications (two-wire or four-
wire). The selection of either RS232 or RS422/RS485 is achieved by specific wiring of the 
serial port connector. No other settings need be changed to select between RS232 and 
RS422/485. 
 

1

3

4

5

6

7

8

9

2

 

Pin 
number 

Communication Standard 
RS232 RS485 

1 Do not connect Rx Data + (In) 
2 Rx Data (In) Rx Data – (In) 
3 Tx Data (Out) Do not connect 
4 Do not connect Tx Data+ (Out) 
5 Ground Ground 
6 Do not connect Vcc 
7 RTS (Out) Do not connect 
8 CTS (In) Do not connect 
9 Do not connect Tx Data – (Out) 

Table 2-2: Pin allocation of Port 1 serial port connector on Teleterm M2. 
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NOTE: The RTS and CTS handshaking lines are available for applications that require them. 
It is not a requirement of the CPU to use handshaking. In most applications connecting the 
RTS and CTS handshaking lines is not necessary. 
 

2.6 Connecting Network Ports 

2.6.1 Teleterm M2G (Models C236xB-11, -12) with internal GSM/3G modem 
2.6.1.1. Inserting the Network SIM Card 

The Teleterm M2G requires a SIM card (not supplied) to enable the unit to 
operate on the selected GSM mobile phone network. 
To insert the SIM card: 
1. Remove the top cover of the Teleterm M2 by undoing the two hex 

screws holding the top cover of the unit, using a 2.5mm hex key 
(supplied). The cover is connected to the unit by the internal antenna 
cable, so be careful not to place any strain on this cable while removing 
the cover or inserting the SIM card. 

 
 

2. Insert the SIM card into the SIM card holder you will see in the centre of 
the unit. Take special care that the SIM card is correctly seated in the 
connector, and that the SIM card holder is properly closed. Press firmly 
down and slide forward to close securely. 

 

 
 

 
3. Replace the top cover. 
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2.6.1.2. Connecting the Antenna 
The supplied Antenna’s cable should be screwed into the Antenna socket. 
Do not over tighten. This connector should be only finger tight to avoid 
damage. 
 

2.6.1.3. Positioning the Antenna 
The antenna should be placed away from the Teleterm M2G in a position 
that gives the best possibility of a good signal on the mobile phone network. 
Avoid proximity of the antenna to shielding materials such as metal 
enclosures. 
The signal strength of the chosen location can be easily checked by holding 
a mobile phone (connected to the same network) in the intended position of 
the antenna, and checking that the signal strength on the phone is good. 
 

CAUTION: The antenna emits RF energy on a continuous basis, and should 
be positioned away from sensitive instrumentation, and away from areas 
where close proximity to personnel on a regular basis would occur. A 
separation distance of in excess of 30cm is recommended. 

 

2.6.2 Teleterm M2C (Model C236xB-21) with Conet network port 
It is recommended that the Teleterm M2C be connected to the Conet network using 
the C6169 Conet Termination Board and interconnecting cable. This ensures the 
integrity of the Conet network during maintenance of the RTU, and provides additional 
surge suppression and protection to the Teleterm M2C. 
 
See the C6169 Datasheet with application notes for full Conet installation details. 
 

 

1

3

4

5

6

7

8

9

2

 
 

Pin number Description 
2 Signal + 
5 Cable screen (S) 
8 Signal - 

1, 3, 4, 6, 7 and 9 No connection 

Table 2-3: Pin allocation of Conet port connector on the Teleterm M2C 

 

2.6.3 Teleterm M2R (Model C236xB-31, -32, -33, -34) with Radio Network Port 
2.6.3.1. Connecting the Antenna 

The M2R RTU is equipped with an RPSMA antenna connector found on the 
top edge of Teleterm M2R RTU. 



Teleterm M2 Series RTU User Manual  

 

 

UMC2360BR05.pdf 18 -© Omniflex 
 

The appropriate antenna suitable for the application must be selected and 
purchased separately. 
Screw the antenna’s cable into the Antenna socket. Do not over tighten. 
This connector should be only finger tight to avoid damage. 
 

2.6.3.2. Positioning the Antenna 
The antenna should be placed away from the Teleterm M2R in a position 
that gives the best possibility of good reception. Avoid proximity of the 
antenna to shielding materials such as metal enclosures. 
The signal strength of the chosen location can be easily checked by using 
the Omniset configuration software. 
CAUTION: The antenna emits RF energy on a continuous basis, and should 
be positioned away from sensitive instrumentation, and away from areas 
where close proximity to personnel on a regular basis would occur. 
 

2.6.4 Teleterm M2S (Model C236xB-41) with two additional Serial Ports 
The M2S is equipped with two additional serial ports called PORT 3 and Port 4. 
Port 3 is capable of either RS232 or RS485 operation. Port 4 is RS232 only with full 
handshaking suitable for driving a modem or other external serial device. 
 
Port 3 is capable of RS232, RS422 or RS485 communications (two-wire or four-wire). 
The selection of either RS232 or RS422/RS485 is achieved by specific wiring of the 
serial port connector. No other settings need be changed to select between RS232 
and RS422/485. 
 

1

3

4

5

6

7

8

9

2

 

Pin 
number 

Communication Standard 
RS232 RS485 

1 Do not connect Rx Data + (In) 
2 Rx Data (In) Rx Data – (In) 
3 Tx Data (Out) Do not connect 
4 Do not connect Tx Data+ (Out) 
5 Ground Ground 
6 Do not connect Vcc 
7 RTS (Out) Do not connect 
8 CTS (In) Do not connect 
9 Do not connect Tx Data – (Out) 

Table 2-4: Pin allocation of Port 3 serial port connector on Teleterm M2S. 

NOTE: This port is not isolated, and the Signal Ground is connected internally to the 
M2S Power Supply 0 Volt connection. 
 
NOTE: The RTS and CTS handshaking lines are available for applications that require 
them. It is not a requirement of the CPU to use handshaking. In most applications 
connecting the RTS and CTS handshaking lines is not necessary. 
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The pin-out of PORT 4 is given in the following table: 
 

Pin 
number 

 
In/Out 

 
Name 

 
Description 

1 I CD Carrier Detect 
2 I RD Received Data 
3 O TD Transmitted Data 
4 O DTR Data Terminal Ready 
5 - SG Signal Ground 
6 I DSR Data Set Ready 
7 O RTS Request To Send 
8 I CTS Clear To Send 
9 I RI Ring Indicator 

Table 2-5: Pin allocation of Port 4 serial port connector on M2S. 

NOTE: This port is not isolated, and the Signal Ground is connected internally to the 
M2S Power Supply 0 Volt connection. 
 

2.7 Powering up the Teleterm M2 
Upon power up, the Teleterm M2 will take approximately a few seconds to initialise the 
system and connect to the network. The front panel LED’s will all light for a short period 
before switching to their operational state. 



Teleterm M2 Series RTU User Manual  

 

 

UMC2360BR05.pdf 20 -© Omniflex 
 

3. Configuring the Teleterm M2 

3.1 Overview 
The Teleterm M2 is configured using the ‘Omniset’ software utility version 7.3 or above. 
Omniset is a Windows98/NT/2000/XP compatible software package designed to configure a 
wide range of Omniflex products, including the Teleterm Teleterm M2. 
Omniset is available in two versions: 
The standard Omniset software is on the CD supplied with the Teleterm M2 RTU. 
Omniset may also be downloaded for free from the Omniflex web site www.omniflex.com . 
Omniset allows the Teleterm M2 to be configured through the serial port on the front of the 
unit. 
The EziFORTH Workbench software is used for more advanced programming of the 
Teleterm M2. 

3.2 Incompatibility with Previous Versions of Omniset 

3.2.1 Versions of Omniset prior to 7.3 
The Teleterm M2 is only compatible with Omniset or Omniset PRO Version 7.3 
onwards. If you have a previous version of Omniset installed on your computer, then 
you need to upgrade to the latest version. 
You can check which version of Omniset you have installed by opening Omniset and 
then selecting the “Help>About…” menu item. 

3.3 Installing Omniset from the CD supplied 
Omniset is Windows98/NT/2000/XP compatible, and requires access to an RS232 port on 
your Windows computer. 
If your computer does not have a serial port available for use with Omniset, then 
inexpensive USB-to-Serial Converter modules are readily available that can be used with 
Omniset. 
To install Omniset from the CD supplied, follow these steps: 

1. Insert the CD into the CD drive of your computer. The Omniset installation should 
start automatically. If it does not, then, using Windows Explorer, navigate on the CD 
drive to the ‘Omniset’ directory and double click the file ‘setup.exe’. 

2. Follow the prompts on the screen to complete the installation. 
3. Select the COM port that you wish to use with Omniset by selecting ‘COM Port’ on 

the Data menu. 
4. Omniset uses “templates” to customise its appearance to suit the product being 

configured. Omniset is supplied with a complete library of templates for all Omniflex 
products, including the Teleterm Teleterm M2. This library is frequently being 
updated with new products and enhancements. If your computer is connected to the 
Internet, you can easily check for and download the latest template library by 
selecting “Update Template Library from Web…” on the Omniset File menu. Follow 
the prompts to update your template library to the latest version. If you installed 

http://www.omniflex.com/
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Omniset from the CD supplied with your Teleterm M2, and you do not have access 
to the Internet then do not worry. You will already have the template necessary to 
configure the Teleterm Teleterm M2 (although it may not be the latest version 
available). 

3.4 Connecting Omniset to the Teleterm M2 for first time 
To setup the Teleterm M2 using Omniset, follow this procedure: 
 

• Plug the programming cable supplied into the serial port on the front of the Teleterm M2 
(marked Port 1) and into a serial port on your computer. 

• Ensure that the Omniset software utility is running on your computer. 

• Hold down the MODE pushbutton on the Teleterm M2, until the MODE LED indicator 
starts to flash green and red alternatively. This places the Teleterm M2 into 
programming mode. 

• Select ‘Connect...’ from the File menu. 
Select the ‘Teleterm’ Product Group if prompted, and press OK: 
 

 
 

If successfully connected, you should see the following screen in Omniset 
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Check that the Product Name is correct for the version of Teleterm M2 connected and that 
the Product/File Compatibility is ‘Yes’. 

Make sure that the Sync button  is depressed, and that the Sync mode icon is 
present in the Status bar at the bottom of the Omniset window. This indicates that Omniset 
is in Sync mode, and that the data visible in Omniset is synchronised with the Teleterm M2 
connected. In this Sync mode, any changes that you make in Omniset will automatically be 
written to the Teleterm M2. If Sync mode is NOT enabled, then changes you make to the 
configuration will NOT be written automatically to the Teleterm M2. You can write these 
values manually to the Teleterm M2 by selecting “Write Current Group” or “Write All 
Groups” from the “Data” menu. 
 
You are now ready to view or change any of the parameters in the Teleterm M2. 

3.5 Overview of the Teleterm M2 Configuration Template 
The pane on the left of the Omniset window shows a list of Groups of Items to be viewed or 
changed, arranged in Folders. Select a Group in the group pane on the left, to see the 
contents of the individual Items for that Group in the item pane on the right. 
By selecting either a Group, or an Item, Help information will be displayed for that Group or 
Item in the Help pane below the Item pane at the bottom of the Omniset window. 
See the Omniset Help for a more detailed description of the operation of Omniset. 
 
There are two important Groups in the left group pane: 
The Real-Time Data Group contains the current status of all data items in the Teleterm M2. 
Select one of the Real-Time Data Groups to see the current data in the Teleterm M2. 
The Configuration Group contains all the Items that can be configured in a Teleterm M2. 
The value of an Item in the right hand pane can be changed in a number of ways: 

1. Double-click the Item or 
2. Right Click the Item and select “New Value…” from the options provided. 

Enter the new value in the dialogue box and then press Enter or the ‘OK’ button. 
Once you have completed the configuration of your Teleterm M2, you should save your 
configuration to your hard drive, so you have a backup of the configuration. 
Remember that if your Omniset is not synchronised to your target Teleterm M2 when you 
make any changes in Omniset, these changes will not be written to the Teleterm M2 until 
you press the “Write” or “Write All” button. 

3.6 Quick Configuration 
This procedure is recommended to check the Teleterm M2 operation for the first time. This 
provides the minimum amount of configuration necessary to achieve a simple functional test. 
This will give you a good starting point for further customisation to suit your specific 
application. 

3.6.1 Set the Real-time Clock 
The Real Time Clock Data Group shows the current date and time in the Teleterm M2, 
the time and date of the last power down, and the time and date of the last power up. 
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To set the real-time clock, write the current time and date to the relevant Data Items in 
this Data Group. The clock will run immediately from this new time when it is written to 
the Teleterm M2. To change a data item, double the Item, or right click and select 
“New Value…”. 
 

 
 

3.6.2 Set the I/O Points to the type required 
The default setting as shipped from the factory is with all inputs set as digital inputs. 
Ensure that these inputs as set as Digital Inputs by selecting the I/O Points Group. 
This gives a summary of each Input setting. 
For detailed configuration of each Input to suite your application, select the actual I/O 
Point in the left Group pane. 
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3.7 Configuring the Programming Port 
This port is set in the factory to its default of Conet/s protocol used for programming the 
Teleterm M2. 
The programming port on the Teleterm M2 comes equipped with four protocols options: 

1. Modbus Master (ASCII and RTU) 
2. Modbus Slave (ASCII and RTU) 
3. Conet/s protocol. 
4. User Protocol (Requires an installed user program to access the serial port) 

CAUTION: It is not recommended that the programming port be assigned to other duties 
other than reserved for programming, because of the increased difficulty for configuration 
changes and debugging caused in the field when the programming port is not available for 
this purpose. 
The programming port can be switched between two operating modes: Program mode and 
General mode. As shipped, the programming port is configured to allow programming in 
either mode. 
Programming Mode is selected by holding down the black SD button on the lower right 
corner of the unit for three seconds. Programming mode is indicated by the Tx1 and Rx1 
LED’ turning steady on. 
When in programming mode, the Prog Port is always set to the Conet/s programming 
protocol required by the programming tools. While in Program mode, the Prog Port’s 
Normal Mode settings may be changed. The required protocol including any address 
selection is made in the “Configuration>Communications>Ports>Programming Port” group 
of Omniset. 
To enable these settings to take effect, the Prog Port must be switched to normal mode by 
holding down the SD button again for three seconds. The Tx1 and Rx1 lights will go off to 
indicate Normal mode, and will resume their normal mode if flashing whenever valid data is 
received. 
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. 
 

 
 
 

3.8 Configuring the Serial Port 1 
The serial port (Port 1) on the Teleterm M2 comes equipped with four protocol options: 

5. Modbus Master (ASCII and RTU) 
6. Modbus Slave (ASCII and RTU) 
7. Conet/s protocol. 
8. User Protocol (Requires an installed user program to access the serial port) 
 

The required protocol including any address selection is made in the 
Configuration>Communications>Ports>Serial Port (Port 1)” Group. 
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81 2 3 4 5 6 7
ON

81 2 3 4 5 6 7
ON

 
 

3.9 Configuring the Conet/c Network Port (available on the Teleterm M2C only.) 
The Conet/c Port selection switch is located on the top edge of the M2 RTU along side the 
Port 2 Conet Network connector. Use this switch to configure the Node address of the RTU 
on the Conet network and the desired CONET baud-rate (Normal or Slow). 
 

Communications Protocol Conet Address switch setting 
 
Conet (Normal mode): 
Baud rate: 62,500 baud 

 
Switches 1-7: Conet ID 
(Set in binary  
Switch 1 = LSB 
Switch 7 = MSB) 
Switch 8: Baud Rate 
Switch 8 OFF = 62.5 kBaud 
[Switch shown set to Address 2, Normal baud rate] 

 
Conet (Slow mode): 
Baud rate: 7,800 baud 

 
Switches 1-7: Conet ID 
Switch 8: Baud  
Switch 8 ON = 7.8 kBaud 
[Switch shown set to Address 2, Slow baud rate] 

Table 3-1: Conet Port Address switch settings on the M2C RTU) 

Each node on the Conet/c network should be allocated a unique address in sequence, 
starting at 1. While a Conet/c network will operate reliably with missing node addresses, 
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best performance of the network will be achieved with all operating nodes having 
consecutive addresses. 
All Conet nodes in a network must be set to the same baud rate. 
 
Please refer to the Conet Installation Guide and Conet Protocol Datasheet for more 
information on the CONET network. 

3.10 Configuring the Conet/r Network Port (available on the Teleterm M2R only.) 
Conet/r is a full peer-to-peer radio network which allows the system designer to take 
advantage of flexible network topologies.  
The following parameters need to be configured in every node in the Conet/r network. 
These parameters can be found in the Omniset “Configuration>Communications> 
Ports>Radio Port” group. 
 
3.10.1 Configuring the Radio Network Node Address 

Each M2R connected to the radio network is considered a "Node" on the network. 
Each node must have a unique address. Set the address for each node uniquely in 
this item. 
Node addresses can be in the range 1 - 65535. 
If the node address is set to 0, then the radio will not transmit data on to the network, 
and will be unable to respond to requests from the network. 
 

3.10.2 Configuring the Inactivity Protection Timer 
This timer is used to reset the radio channel when an unacceptable length of time has 
elapsed without radio communications. In unusual network conditions it is possible for 
the radio network to enter a “deadlock” condition, where radio communications is 
prevented. This protection timer is used to prevent this extreme condition from 
causing permanent loss of communications. 
Set this timer to longer than you expect the network to ever be quiet. If this timer times 
out without network activity, then the M2 will assume that a deadlock condition has 
occurred, and will reset the radio channel to allow communications to resume. 
 

3.10.3 Configuring the Hopping Sequence Number 
The Conet/r network uses a Frequency Hopping Spread Spectrum (FHSS) to improve 
noise immunity and to allow multiple networks to exist within range of each other. 
FHSS is a technique where the transmitting node transmits for short time on one 
frequency and then hops to another frequency to continue transmission, and so on 
through a range of frequencies in a particular order. The frequencies are used in a 
predefined pseudo-random sequence that both the transmitter and receiver know. 
Receiving nodes listen in order on each of these frequencies to receive the entire 
message. 
Because the system transmits on a number of frequencies, the communication is 
more reliable and resistant to interference than a a system operating on a single 
frequency. 
By varying the hopping sequence, different radio networks can coexist within the 
same geographic area. 
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The M2R can be set with one of 7 Hopping Sequences (0-6). All nodes on a single 
network must have the same Hopping Sequence Number. 
 

3.10.4 Configuring the node as a Repeater or End Node 
If an RF link is weak, an M2R in the network is out of range, or a difficult RF 
environment is present, then repeaters can be used to extend the effective range and 
reliability of the radio network. 
A repeater is a regular Teleterm M2R node that has repeating enabled. Any node in a 
Conet/r network can be designated as a repeater node or as an end node. 
Select “Repeater Node” for radios that you wish to perform the repeater function. All 
other nodes must b set to “End Node”. 
 

3.11 Other Configuration Settings 
There are a number of other settings that can be made in Omniset to fully configure your 
Teleterm M2. The settings for your particular M2 RTU will vary dependent upon the model. 
There is an Omniset Template customised for each version of M2 RTU.  
Browse through all of the Configuration Groups in Omniset. The Help pane in Omniset will 
explain each of these additional settings. 

3.12 Programming the M2 RTU in EziFORTH 
Please refer to the separate EziFORTH Programmer’s Manual. 
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4. Modbus and the Teleterm M2 

4.1 Overview 
A unique and powerful feature of the Teleterm M2 is its ability to read data from any device 
equipped with a Modbus port and send SMS Alarm messages based upon the contents of 
that data. 
Examples of equipment that can be interrogated for alarm data are instruments such as 
PLC’s, SCADA packages, on-line analysers, flow meters etc. 
Modbus is the most popular standard for the exchange of data between industrial 
instrumentation today. Modbus is a well established reliable standard that is easy to use. 
Modbus is a serial multi-drop Master/Slave protocol. This means that you can connect one 
or more Slave devices to a Master device over a serial communication link. If only one 
Slave device is being used, and the distance between the Master and Slave devices is less 
than 15m, then the simpler more popular RS232 electrical standard can be used. If two or 
more Slaves are to be connected to the Master Device, or the distance between the devices 
is greater than 15m, then the RS485 electrical standard must be used. 
There are no internal settings in the Teleterm M2 for selecting RS232 or RS485. All that is 
required is to wire the appropriate pins of the serial connector for the chosen standard. 

4.2 Modbus Slave 

4.2.1 Selecting the Slave Protocol Details 
Setting up Modbus Slave protocol only requires configuration of the serial port in the 
“Configuration>Communications>Serial Port” group, including ASCII and RTU mode, 
Baud Rate, Parity, number of Data bits and Stop bits etc. 
The simplest operating mode for Modbus Slave is to configure the Teleterm M2 (and 
the Master Device) as follows: 
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4.2.2 Modbus Data Register Mapping 
The Modus protocol in the Teleterm M2 supports the reading and writing of a number 
of different types of data: Digital Status Inputs, Coil Outputs, Input Registers and 
Holding Registers. 
These Modbus Data types are mapped to specific areas of the Teleterm M2’s Scratch 
Pad Registers. It is not normally necessary to change this layout, but you may do so 
for specific applications. The default settings are as follows: 
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The most efficient data type to use is Holding Register Read (Modbus Function 3) and 
Holding Register Write (Modbus Function 16). 

4.3 Modbus Master 

4.3.1 Selecting the Master Protocol Details 
Setting up Modbus Master protocol requires configuration of the serial port in the 
“Configuration/Communications/Serial Port” group, including ASCII and RTU mode, 
Baud Rate, Parity, number of Data bits and Stop bits etc. 

4.3.2 Query Blocks 
In order to use the Modbus Master facility in the Teleterm M2 to get data from another 
Modbus Slave, “Query Blocks” have to be configured that tell the Teleterm M2 where 
to get the data from which Slave, where in the Teleterm M2 to place the data, and 
which Modbus Function to use to acquire the data. 
Up to 32 Query Blocks can be configured in the Teleterm M2: 
 

 
 
In the example shown above for Query 01, each data item has the following meaning: 
Query Type Cyclic: This means that the query will repeat on a timed cycle as set. 
Update Time: This setting shows often the query will be sent – in this case every 500 
milliseconds (0.5 seconds). 
Modbus Function Number: There are number of types of messages called 
“functions” that the Modbus protocol supports. Function 3 for reading general purpose 
Holding Registers is the most commonly used for this purpose because it is the most 
efficient for reading larger amounts of data. 
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Function Description 
1 Read Coil Status 
2 Read Input Status 
3 Read Multiple Holding Registers 
4 Read Multiple Input Registers 
5 Write Single Coil 
6 Write Single Holding Register 

15 Write Multiple Coils 
16 Write Multiple Holding Registers 

 
 
Slave ID: This is the Modbus Address of the Slave device to be polled. 
Slave Start Address: This is the address of the first Holding Register to be read from 
the Slave device, 
Range: This is the number of Holding registers to be read from the Slave device. 
Local DIT Start: This is the starting address of the local Register in the Teleterm M2 
where the data will be written. The registers in the range 350 to 399 are reserved for 
this purpose in the Teleterm M2. 
 
Once the Queries required are configured, then you need to unplug the programming 
cable from the serial port, switch the serial port back to normal mode by holding down 
the Mode pushbutton until the OK light is steady green, and then plug in the slave 
device to the serial port. 
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5. The Data Interchange Table explained 

5.1 DIT Table Layout 
All data exchange with the M2 RTU is done via the “Data Interchange Table” (DIT). Any 
exchange of data between functions in the M2 RTU and/or with the outside world takes 
place through this DIT. 
The Data Interchange Table (DIT) in the M2 RTU is used for reading and writing all 
configuration and dynamic data in the M2. 
The DIT is an array of 16 bit registers accessible from any function or communications port 
in the M2 RTU. Even the Omniset configuration template interfaces to the M2 RTU through 
the DIT. 
Each data register in the DIT has a data address on the range 0 to 65535. Not all 
addresses are accessible. See the DIT Table Detailed Layout in Section 8 for more details 
for your particular product. 
Any of these registers may be accessed through any of the network ports, allowing remote 
I/O systems to be implemented “out-of-the-box” without any programming required. 
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6. The Subscription Service Explained 

6.1 Introduction to Subscriptions 
Central to many applications involving communications across networks is the need to 
replicate data between nodes on the network. 
Examples include a SCADA system acquiring data from remote telemetry units in the field; 
or a point-to-point telemetry application, where inputs are transmitted from one location to 
outputs at another location. 
In all these cases, the traditional method is for a controlling master node to poll the slave 
nodes regularly for data in case something has changed. This crude method is an inefficient 
use of the limited network bandwidth, and is inherently slow in typical and worst case 
update times. It also limits the number of master nodes in the system to one, and makes the 
system update times very slow where many outstations are involved. 
The Teleterm M2 provides a far superior mechanism to accomplish this commonly used 
function through its Subscription Service. The subscription Service runs on all Conet/c 
(industrial LAN), and Conet/r (FHSS radio) and Conet/e (Ethernet) networks, and is 
supported on all Omniflex products supporting these network types. This allows the M2 
RTU to be used as remote I/O for other Omniflex equipment such as the Maxiflex Process 
Automation Controller Suite of products, or to be interconnected in a unified data 
environment. 

6.2 How Subscriptions Work 
The Subscription Service operates as follows: 
The node requiring the data (the receiver) sets up a subscription with the node that has the 
data (the sender), very much like you would subscribe to a magazine through your 
newsagent. You establish a magazine subscription by telling the newsagent which 
magazine you want, your home address, and how often you want it, and then the 
newsagent takes the responsibility to send you the magazine whenever a new issue 
becomes available. 
 

 

Subscriber Newsagent

Request subscription

August issue

September issue

October issue

etc...   

Figure 6.1 The Magazine Subscription Analogy. 

 
In the same way, the M2’s Subscription Service allows the M2 (acting as a node on the 
network) to subscribe to a range of DIT registers on a remote node. 
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The remote node will then send the data at an agreed time interval, plus, if required, when 
the data changes state. The receiving node expects these regular updates, and will flag an 
error if the subscribed data is interrupted for any reason. 
 

6.3 Setting up subscriptions 
Just like the magazine subscription, the receiving M2 is responsible for setting up and 
maintaining subscriptions with other nodes to replicate data across the network. The 
advantages of using subscriptions over regular polling mechanisms are as follows: 

1. Only one message is required on the network for a data update as opposed to two in a 
Request/Reply polling method. This reduces network overhead allowing more data 
throughput on the network. 

2. The regular data updates can be much slower than the response time required for the 
system by using change-of-state detection. The Source node will send data 
immediately there is a change of state, providing the optimum system response, 
without the need to have a fast regular update time. This reduces network overhead 
allowing more/faster data throughput on the network when something does change. 

3. On peer-to-peer networks multiple subscriptions can be configured between nodes in 
different directions, each of which would operate independently of any other. This 
provides far more flexibility than typical Poll/Response Master/Slave methods. 

 
 
 

Data
Sink

Data
Source

Subscription
Setup

Registers

Setup Message

Regular Data updates

The Receiving
Node

The Sending
Node  

 
 
 
The node acting as a data “producer” (the sending node) requires no user configuration to 
participate in a subscription contract with another node. The node acting as data 
“consumer” (the receiving node) is configured by the user for the required data. The 
“consumer” node then automatically manages the subscription including sending the 
requests to the data source, and managing errors in the process. 
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The following table shows the information required to configure a subscription:  
 

ITEM DESCRIPTION VALID RANGE 

Change-of-State Required This sets whether the subscription data block will be sent 
when any data in the block changes. 

Yes/No 

Update time This is the time between regular updates of data that will 
be sent whether the data has changed or not. 

1 – 63 seconds, 1-63 minutes 

Communications Port This is the Network Port in this, the receiving node, to 
which the network containing the remote (source) node is 
connected. 

Refer to the relevant product 
template file for network ports 
available on specific product 
suitable for subscriptions. 

Destination DIT Start Address This is the first DIT register address where the data will be 
written in this receiving node. 

0 – 65535 

Source Node Address This is the node address of the sending or source node 
from where the required data originates. 

This can be expressed as a local network address plus 
the local slot and port to which the network is connected, 
or it can be expressed as a global network address if 
network routing is configured in the CPU. 

0-65535 on Conet/r 

0-126 on Conet/c (local) 

128-254 on Conet/c (global) 

Source DIT Start Address This is the first DIT register address of the block of 
registers to be sent from the source node. 

0 – 65535 

Data Range This is the number of 16 bit DIT registers that will be 
transferred in the subscription. 

1 – 120 

Table 6-1 Subscription Configuration Information 

 

6.4 Number of subscriptions allowed 
There is a limit to the number of subscriptions that a Teleterm M2 RTU can receive, and a 
limit to the number of subscriptions that it can send. The M2 RTU can be configured to 
receive subscriptions from a maximum of 16 other nodes and can send subscriptions to a 
maximum of 8 other receiving nodes. 
In other words each M2 RTU can act as data receiver for 16 subscriptions, and data sender 
for up to 8 subscriptions simultaneously. 

6.5 Subscription Application Example 
Refer to the diagram of a simple network below: 
 

C O N ET

N ode Address 2 N ode Address 5

N ode 2 subscribes to
data from  N ode 5
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Remote node 5 on the CONET network has digital information in DIT register 100. Node 2 
needs to monitor these digital inputs. A regular update time of every 10s is quite satisfactory 
to determine that the remote system is still connected and functioning if nothing changes, 
but the data should be sent immediately if any of the digital inputs changes state. 
Node 2 is the Destination node (it sets up the subscription and receives the data). Node 5 is 
the sending node, and requires no user configuration to participate in the subscription 
process. 
Fill in the following data into one of the eight subscription blocks in the Subscription Table in 
the T2 CPU of Node 2 to configure this function: 
 

NAME VALUE DESCRIPTION 

Change of State Required Yes The data will also be sent whenever any bit the 
DIT registers 100 changes. 

Update Time 10 The regular updates can be 10 seconds apart. 

Local Port Number 2 The CONET network is Port 2 on the M2C 

Destination DIT Start Address 100 This is the DIT Address in the receiver where we 
want to start writing the received data. 

Source Node Address 5 The local CONET ID on the Conet network 

Source DIT Start Address 110 The Source Data start at DIT address 620 

Data Range 1 We require 1 DIT register to be sent 

Table 6-2 Subscription Block Data Example 

 
When configured, Node 2 automatically requests a subscription with the data from Node 5 
on the Conet network. 
Node 5 undertakes to send the contents of its own DIT register 100 over the network to 
node 2 whenever any of the bits change, or every 10s if no change occurs in that time. The 
information will be placed in node 2's DIT register 110. 
Node 2 can monitor the status of the subscription by monitoring the relevant bit in the 
Subscription Status DIT register. If this bit is clear then the subscription is operating 
successfully. If this bit is set, then the subscription has failed and received data is not valid, 
or the subscription has not been correctly set. 
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7. Detailed DIT Layout 

7.1 Dynamic Data Area 
(DIT Registers 0 – 29999) 
These are “volatile” registers. i.e. They are not retained on power fail. 

 

7.1.1 System Information 

System Information 
DIT 
Start 

No. of 
DITs 

Datatype Description 

0 1 BCD4 Product Code 
Unique Number in BCD format that reflects the version of the product as 
follows: 
 0350 – M2360B-0 M2 
 1350 – M2360B-11 M2G (GSM) 
 2350 – M2360B-12 M2G (3G) 
 3350 – M2360B-21 M2C (Conet Industrial LAN) 
 4350 – M2360B-31 M2R (2.4GHz) 
 5350 – M2360B-32 M2R (920MHz) 
 6350 – M2360B-41 M2S (Serial Port) 

1 1 BCD4 Firmware/DIT Revision 
Number in BCD containing the firmware revision in the format MM.mm 
MM = Major firmware version number, which also reflects the version of the 
DIT layout. If the DIT layout changes, then the major version will also 
change. 
mm = minor firmware version number. 
e.g. 0614 (BCD) = Firmware Version 6.14 

2 1 BIN16 Supported Functions 
Indicates any special functions enabled on this unit. 

3 1 BCD4 Application Version 
The version number of any factory loaded application. 

4 4 ASCII User Tag Name 
The user is able to write up to 8 ASCII characters into these DIT registers 
(two characters per register) to uniquely identify each Teleterm M2. 
This User Tag Name is used by the Omniset software tool to verify that the 
matching M2 is connected. If this Tag Name is populated, then it must match 
the Tag Name set in Omniset to allow the configuration to be changed. 

8 1 BCD4 Configuration Version 
The configuration version in the format MM.mm 
MM = Major configuration version number. 
mm = minor firmware version number. 
e.g. 0103 (BCD) = Configuration Version 1.03 
This number is set in Omniset from the “File>Properties…” menu. When a 
“Write All Groups” is performed in Omniset, this register is written with the 
value set here. Assists the user to check the configuration version loaded. 

9 1 UNIT16 Configuration Revision 
This number is automatically incremented in Omniset and written to the 
target when a “Write All Groups” is performed. 

10 2 UINT32 MJD Current Date 
The current date in “Modified Julian Date” (MJD) format. 
(Number of days elapsed since 17 November 1858) 

12 2 UINT32 IEC Current Time 
The current time in IEC time format. 
(number of 100us periods since midnight) 
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14 2 UINT32 MJD Power Down Date 
Date of last power down in MJD format. 

16 2 UINT32 IEC Power Down Time 
Time of last power down in IEC time format. 

18 2 UINT32 MJD Power Up Date 
Date of last power up in MJD format. 

20 2 UINT32 IEC Power Up Time 
Time of last power up in IEC time format. 

22 1 BIN16 System Register 
Bit 0: User Program HALTED (0) or RUNNING (1) 
Bit 1: Clock Backup Battery HEALTHY (0) or LOW (1) 
Bit 2: I/O Fault 
Bits 3-15: Reserved 

23 1 UINT16 Alive Counter 
16 bit Running counter increments every 10ms. 

24 6 - Reserved 
30 1 INT16 PSU Voltage 

Incoming Power Supply Voltage with 0.1V resolution. 
31 1 INT16 Temperature 

CPU temperature with 0.1degC resolution. 
32 1 INT16 RTC Battery Voltage 

Backup Battery Voltage with 0.1V resolution 
33 1 - Reserved 
34 1 INT16 SD Card Status 
35 1 UINT16 SD Card Memory Used (%)_ 
36 1 UINT16 SD Card Memory Available (%) 
37 13 - Reserved 

 

7.1.2 Communications Port Status 

Communications Port Status 
50 1 UINT16 Programming Port Inactivity Counter 
51 1 UINT16 Serial Port Inactivity Counter 
52 1 UINT16 Network Port 1 Inactivity Counter 
53 1 UINT16 Network Port 2 Inactivity Counter 
54 1 UINT16 Prog Port Local ID 
55 1 UINT16 Serial Port Local ID 
56 1 UINT16 Network Port 1 Local ID 
57 1 UINT16 Network Port 2 Local ID 
58 1 UINT16 Prog Port Global ID 
59 1 UINT16 Serial Port Global ID 
60 1 UINT16 Network Port 1 Global ID 
61 1 UINT16 Network Port 2 Global ID 
62 1 UINT16 Serial Port Dipswitch 
63 1 UINT16 Network Port 1 Dipswitch 
64 1 UINT16 Network Port 2 Dipswitch 
65 15 - Reserved 

 

7.1.3 EventForth System Timers 

EventForth System Timers 
80 1 UINT16 System Timer 0 
81 1 UINT16 System Timer 1 
82 1 UINT16 System Timer 2 
83 1 UINT16 System Timer 3 
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84 1 UINT16 System Timer 4 
85 1 UINT16 System Timer 5 
86 1 UINT16 System Timer 6 
87 1 UINT16 System Timer 7 
88 12 - Reserved 

 

7.1.4 Network Status 

M2R Signal Strength 

100 1 2 x UINT8 

M2R: Node Page Selection 
(0= node 1-20;1= Node 21-40, 2 = 41-60 etc,.) 
This register sets the page of 20 nodes to view for both RSSI and Network 
Inactivity Timers in the next table. 

101 1 2 x UINT8 M2R: RSSI Node 1 & 2 
102 1 2 x UINT8 M2R: RSSI Node 3 & 4 
103 1 2 x UINT8 M2R: RSSI Node 5 & 6 
104 1 2 x UINT8 M2R: RSSI Node 7 & 8 
105 1 2 x UINT8 M2R: RSSI Node 9 & 10 
106 1 2 x UINT8 M2R: RSSI Node 11 & 12 
107 1 2 x UINT8 M2R: RSSI Node 13 & 14 
108 1 2 x UINT8 M2R: RSSI Node 15 & 16 
109 1 2 x UINT8 M2R: RSSI Node 17 & 18 
110 1 2 x UINT8 M2R: RSSI Node 19 & 20 
111 16   Reserved 

 

Network Inactivity Timers (paged in groups of 20) 
127 1 UNIT16 M2R: Inactivity Node 1 (paged with RSSI above) 
128 1 UNIT16 M2R: Inactivity Node 2 
129 1 UNIT16 M2R: Inactivity Node 3 
130 1 UNIT16 M2R: Inactivity Node 4 
131 1 UNIT16 M2R: Inactivity Node 5 
132 1 UNIT16 M2R: Inactivity Node 6 
133 1 UNIT16 M2R: Inactivity Node 7 
134 1 UNIT16 M2R: Inactivity Node 8 
135 1 UNIT16 M2R: Inactivity Node 9 
136 1 UNIT16 M2R: Inactivity Node 10 
137 1 UNIT16 M2R: Inactivity Node 11 
138 1 UNIT16 M2R: Inactivity Node 12 
139 1 UNIT16 M2R: Inactivity Node 13 
140 1 UNIT16 M2R: Inactivity Node 14 
141 1 UNIT16 M2R: Inactivity Node 15 
142 1 UNIT16 M2R: Inactivity Node 16 
143 1 UNIT16 M2R: Inactivity Node 17 
144 1 UNIT16 M2R: Inactivity Node 18 
145 1 UNIT16 M2R: Inactivity Node 19 
146 1 UNIT16 M2R: Inactivity Node 20 
147 33 - Reserved 
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7.1.5 Subscription Status 

Subscription Status 
180 1 BIN16 Bit Status for Subscriptions 1 to 16 
181 1 BIN16 Bit Status for Subscriptions 17 to 32 
182 1 BIN16 Bit Status for Subscriptions 33 to 48 
183 1 BIN16 Bit Status for Subscriptions 49 to 64 
184 6 - Reserved 

 

7.1.6 Modbus Master Query Status 

Modbus Master Query Status 
190 1 UINT16 Last Known Error Code 
191 1 BIN16 Bit Status for Queries 1 to 16 
192 1 BIN16 Bit Status for Queries 17 to 32 
193 1 BIN16 Bit Status for Queries 33 to 48 
194 1 BIN16 Bit Status for Queries 49 to 64 
195 1 BIN16 Query Tigger 1 to 16 
196 1 BIN16 Query Tigger 17 to 32 
197 1 BIN16 Query Tigger 33 to 48 
198 1 BIN16 Query Tigger 49 to 64 
199 1 - Reserved 

 

7.1.7 ISaGRAF Program Information 

Isa GRAF Program Information 
200 8 ASCII Application Name 
208 2 UINT32 Application Date 
210 2 UINT32 Application Checksum 
212 1 UINT16 Application Version 
213 1 INT16 Program Space % Used 
214 1 INT16 Variable Space % Used 

 

7.1.8 Digital Input Status 

Digital Input Status 
250 1 BIN16 Digial Input Status - DI 1 to 12 
251 1 BIN16 Alarm Status - Alarm 1 
252 1 BIN16 Alarm Status - Alarm 2 
253 1 BIN16 Alarm Status - Alarm 3 
254 1 BIN16 Alarm Status - Alarm 4 
255 5 - Reserved 

 

7.1.9 Digital Output Status 

Digital Output Status 
260 1 BIN16 Digital Output Status - DO 1 to 10 
262 8 - Reserved 
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7.1.10 Analogue Input Values 

Analogue Input Values 
270 1 INT16 Measured Input A1 
271 1 INT16 Measured Input A2 
272 1 INT16 Measured Input A3 
273 1 INT16 Measured Input A4 
274 1 INT16 Measured Input A5 
275 1 INT16 Measured Input A6 
276 1 INT16 Measured Input A7 
277 1 INT16 Measured Input A8 
278 1 INT16 Measured Input A9 
279 1 INT16 Measured Input A10 
280 1 INT16 Measured Input A11 
281 1 INT16 Measured Input A12 
282 8 - Reserved 
290 2 INT32 Engineering Input E1/Counter Input C1 
292 2 INT32 Engineering Input E2/Counter Input C2 
294 2 INT32 Engineering Input E3/Counter Input C3 
296 2 INT32 Engineering Input E4/Counter Input C4 
298 2 INT32 Engineering Input E5/Counter Input C5 
300 2 INT32 Engineering Input E6/Counter Input C6 
302 2 INT32 Engineering Input E7/Counter Input C7 
304 2 INT32 Engineering Input E8/Counter Input C8 
306 2 INT32 Engineering Input E9/Counter Input C9 
308 2 INT32 Engineering Input E10/Counter Input C10 
310 2 INT32 Engineering Input E11/Counter Input C11 
312 2 INT32 Engineering Input E12/Counter Input C12 
314 6   Reserved 

 

7.1.11 Analogue Output Status 

Analogue Output Status 
340 2 INT32 Engineering Output F11 
342 2 INT32 Engineering Output F12 
344 16 - Reserved 
360 1 INT16 Calibrated Output B11 
361 1 INT16 Calibrated Output B12 
362 8   Reserved 

 

7.1.12 User Dynamic Registers 
The following registers are available for the user. These register contents are NOT 
retained during power down. 

User Area 
500 29499   User Area – Volatile Registers 
29999     Last Dynamic DIT 
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7.2 Static Data Area 
(DIT Registers 30000 – 65000) 
These are “non-volatile” registers. i.e. They are retained on power fail. 
CAUTION: It can take up to three seconds for data written to these registers to be saved to 
non-volatile memory. Any values changed within three seconds of a power failure may NOT 
be saved. 

 

7.2.1 Input Configuration 

Input Configuration 
30000 50 INT16 Configuration Input 1 
30050 50 INT16 Configuration Input 2 
30100 50 INT16 Configuration Input 3 
30150 50 INT16 Configuration Input 4 
30200 50 INT16 Configuration Input 5 
30250 50 INT16 Configuration Input 6 
30300 50 INT16 Configuration Input 7 
30350 50 INT16 Configuration Input 8 
30400 50 INT16 Configuration Input 9 
30450 50 INT16 Configuration Input 10 
30500 50 INT16 Configuration Input 11 
30550 50 INT16 Configuration Input 12 

 

7.2.2 Serial Port 1 Configuration 

Port 1 Setup (Serial Port - main board) 
30610 1 UINT16 Protocol and comms setting 
30611 1 UINT16 RTS/CTS Timeout 
30612 8 - Reserved for Port 

 

7.2.3 Serial Port 2 Configuration 

Port 2 Setup (Second Serial Port – M2S Only) 
30620 1   Protocol and comms setting 
30621 1   RTS/CTS Timeout 
30622 8   Reserved for Port 

 

7.2.4 Programming Port Configuration 

Prog Port Setup 
30630 1 UINT16 Protocol and comms setting 
30631 1 UINT16 RTS/CTS Timeout 
30632 8 UNIT16 Reserved for Port 
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7.2.5 Modbus Port Configuration 

Modbus Slave Register map 
30690 8  Modbus Slave Register Map 
30698 2  Reserved 

 

Modbus Master Query Configuration 
30700 1 UINT16 Query Response Timeout 
30701 1 UINT16 Interquery Delay (ms) 
30702 1 UINT16 Interpoll Delay (ms) 
30703 1 UINT16 Retries 
30704 4 - Reserved 
30708 1 UINT16 Query 1: Update Time 
30709 1 2 x UINT8 Query 1: Slave ID (msb) : Function (lsb) 
30710 1 UINT16 Query 1: Slave Start Address 
30711 1 UINT16 Query 1: Range 
30712 1 UINT16 Query 1: Local DIT Start 
30713 1 UINT16 Query 1: Local Port Number (msb) : Local BIT position (lsb) 
30714 4 UINT16 Reserved for future (I.e. IP address for Modbus Master TCP) 
30718 10  Query 2 - as per Query 1 
30728 10  Query 3 - as per Query 1 
30738 10  Query 4 - as per Query 1 
30748 10  Query 5 - as per Query 1 
30758 10  Query 6 - as per Query 1 
30768 10  Query 7 - as per Query 1 
30778 10  Query 8 - as per Query 1 
30788 10  Query 9 - as per Query 1 
30798 10  Query 10 - as per Query 1 
30808 10  Query 11 - as per Query 1 
30818 10  Query 12 - as per Query 1 
30828 10  Query 13 - as per Query 1 
30838 10  Query 14 - as per Query 1 
30848 10  Query 15 - as per Query 1 
30858 10  Query 16 - as per Query 1 

 

7.2.6 Network Subscription Configuration 

Subscription Configuration 
31398 1 UINT16 Subscription Cancellation Timeout 
31399 1 UINT16 Subscription Cancellation Retries 
31400 1 UINT16 Sub 1: Message Type 
31401 1 UINT16 Sub 1: Update Time 
31402 1 UINT16 Sub 1: Local Hardware Port 
31403 1 UINT16 Sub 1: Local DIT Start 
31404 1 UINT16 Sub 1: Remote ID 
31405 1 UINT16 Sub 1: Remote DIT Start 
31406 1 UINT16 Sub 1: Range 
31407 2 UINT16 Reserved 
31409 7 UINT16 Reserved 
31416 16  Subscription 2 – as per subscription 1 
31432 16  Subscription 3 – as per subscription 1 
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31448 16  Subscription 4 – as per subscription 1 
31464 16  Subscription 5 – as per subscription 1 
31480 16  Subscription 6 – as per subscription 1 
31496 16  Subscription 7 – as per subscription 1 
31512 16  Subscription 8 – as per subscription 1 
31528 16  Subscription 9 – as per subscription 1 
31544 16  Subscription 10 – as per subscription 1 
31560 16  Subscription 11 – as per subscription 1 
31576 16  Subscription 12 – as per subscription 1 
31592 16  Subscription 13 – as per subscription 1 
31608 16  Subscription 14 – as per subscription 1 
31624 16  Subscription 15 – as per subscription 1 
31640 16  Subscription 16 – as per subscription 1 

 
 

User Configuration Area 
34000 4000  Non-volatile registers available to the user 
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8. Maintenance 

8.1 Battery Type 
The Teleterm M2 is equipped with an internal clip-in battery for retaining the real time clock 
during power failures. 
This battery is a type CR2032 Lithium Battery. This battery is commonly available from 
electronic stores or can be obtained from Omniflex by specifying Part Number 3.5701.001 
It is recommended that the battery be replaced at least every three years, or when the 
battery low indicator in the Teleterm M2 shows LOW. (See the Real Time/Product Status 
Group in Omniset. 
 

8.2 Battery Replacement Procedure 
To replace the internal battery proceed as follows: 
1. Remove the top cover of the Teleterm M2 by undoing the two hex cover screws on the 

top of the unit. The cover is connected to the unit by the internal antenna cable, so be 
careful not to place any strain on this cable while removing the cover or inserting the 
SIM card. 

2. You will see the battery toward the left lower side of the unit. 
3. Unclip the old battery and replace with a new battery  
4. Replace the top cover. 
5. Restore power to the Teleterm M2. 
6. Using Omniset, check that the Battery Indicator is showing “Healthy” 
7. Take care in disposing of the old Lithium battery to preserve the environment, and to 

prevent accidents. 
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9. Technical Support 

Lifetime technical support for all Omniflex products is available by email on 
techsupport@omniflex.com.  
 
Alternatively, you can check the knowledgebase on the Omniflex web site at www.omniflex.com.  
 
 
 
 
 
 
 
 
 
 
 

COPYRIGHT AND PROTECTIVE NOTICES 
1. The Copyright of this document and the associated drawings, is the property of Omniflex and 

is issued on condition that it is not copied, reprinted or reproduced or transmitted in any form 
or by any means, electronically, photocopying, mechanical or otherwise, nor its contents 
disclosed, either wholly or in part, without the consent in writing of, or in accordance with the 
conditions of a contract with Omniflex. 

2. The publication of information in the document does not imply freedom from patent or other 
protective rights of Omniflex or others. 

3. Although every intention is made to ensure that performance figures and data are accurate the 
company reserves the right to alter without notice any product or specification.  Performance 
figures and data must therefore be specifically confirmed by the company before they become 
applicable to any tender, order or contract. 

4. In the case of electrical components, enough data is included in the drawings to allow 
maintenance of the equipment.  However, if component availability or substitution information 
is required please consult the factory for assistance, as it is impossible to include data on 
every component in this document. 

5. This product is sold without liability for consequential loss of any description. 
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